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Introduction to Mobile Connect
SonicWall® Mobile Connect™ for iOS is an application for Apple iPhone, iPod touch, and iPad that enables
secure, mobile connections to private networks protected by SonicWall security appliances.

Topics:
• How Mobile Connect Works
• New Features in Mobile Connect 5.0
• Additional Feature Information
• Supported Platforms

How Mobile Connect Works
Modern business practices increasingly require that users be able to access any network resource (files, internal
websites, and so on), anytime, anywhere. At the same time, ensuring the security of these resources is a
constant struggle. While most users are aware that they must take care to protect computers from network
security risks, this security awareness does not always extend to mobile devices like the iPhone, iPod touch and
iPad. And yet, mobile devices are increasingly subject to security attacks. Furthermore, mobile devices often use
insecure, untrusted, public Wi-Fi hotspots to connect to the Internet. It is therefore a challenge to provide
secure, mobile access while still guarding against the inherent security risks of using mobile devices.
The SonicWall Mobile Connect application for iPhone, iPod touch, and iPad provides secure, mobile access to
sensitive network resources. Mobile Connect establishes a Secure Socket Layer Virtual Private Network (SSL
VPN) connection to private networks that are protected by SonicWall security appliances. All traffic to and from
the private network is securely transmitted over the SSL VPN tunnel.
The Mobile Connect client certificate importer capability allows you to obtain digital security certificates, issued
by certification authorities, to confirm your identify. They contain information used to protect data or to
establish secure network connections. The certificates are securely stored so that only Mobile Connect has
access to them for your protection. No other applications have access to your client certificates.

After installing the SonicWall Mobile Connect application from the App Store:
1 Ensure that the SonicWall Secure Mobile Access (SMA), Secure Remote Access (SRA) or firewall
appliance, that will be used by Mobile Connect to the network, is connected.
2 Configure Network Information (server name, username, password, and so on).
3 Mobile Connect establishes a SSL VPN tunnel to the SonicWall security appliance.
You can now access resources on the private network. All traffic to and from the private network is securely
transmitted over the SSL VPN tunnel.
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New Features in Mobile Connect 5.0
This section describes the enhancements included in Mobile Connect 5.0.
• iOS 11 Compatibility – Mobile Connect has adopted the bold, dynamic new style elements introduced in
iOS 11 including large title bars, landscape tab bars and more.
• Client Certificate Importer – Allows a user to import client certificates for logging into remote servers.
These digital certificates are sent from the client to the server at the start of a session. They prove the
identification of the user. You can import client certificates from apps such as Mail, Outlook, or web
browsers like Safari. Supported starting in Mobile Connect 5.0.4.
• Network Extension Support – Mobile Connect also leverages Apple's current VPN framework, called
Network Extension, to allow for more reliable VPN connectivity on iOS devices. After upgrading to the 5.0
version, Mobile Connect may need to be re-provisioned, including updating VPN connection
configurations and certificates.
• Secure Web Bookmarks – Web bookmarks can now be launched within Mobile Connect instead of
launching a third party browser, allowing for a seamless and more secure user experience. Secure Web
Bookmarks also support Single Sign-On and require a connection to a VPN server with software that
supports the secure web bookmark policy.
• Additional Touch ID Support – Mobile Connect now supports Touch ID for VPN connections to supported
SMA 1000 series servers.
• Face ID Support – Mobile Connect now supports Face ID for VPN connections to supported SMA 100 and
SMA 1000 series servers.
• Global HA Support – Mobile Connect contains updates for the global high availability and disaster
recovery capabilities for VPN connections to SMA 1000 Series servers running 12.1 or newer firmware.
• Localization – Mobile Connect now supports Korean and Chinese languages.
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Additional Feature Information
SonicWall Mobile Connect continues to support the following features:
• Slide Over and Split View – Mobile Connect supports Slide Over and Split View multitasking on iPad.
• Touch ID Support - Apple's Touch ID is a seamless way to use your fingerprint as a passcode. On Touch ID
enabled devices, Mobile Connect permits Touch ID to be used as a substitute for username and password
authentication if allowed by the VPN server. Instead of manually typing in the username and password
on the login screen, a user can simply authenticate with their fingertip. Requires compatible server
software with configured Touch ID policy.
• Face ID Support - Apple's Face ID is a seamless way to use facial recognition as a passcode. On Face ID
enabled devices, Mobile Connect permits Face ID to be used as a substitute for username and password
authentication if allowed by the VPN server. Instead of manually typing in the username and password
on the login screen, a user can simply authenticate using Face ID. Requires compatible server software
with configured Face ID policy.
• Files Bookmarks - Files bookmarks are supported for FTP and SFTP servers in addition to CIFS servers.
• HTML5 Bookmarks with SSO - Mobile Connect supports in-app access with Single Sign-On for HTML5
Bookmarks including RDP, VNC, and SSH.
The following third party apps are supported:
• Microsoft Remote Desktop
• ServerAuditor
• vSSH
HTML5 Bookmarks are displayed natively within Mobile Connect and provide a seamless and more
secure user experience, including support for Single Sign-On.
HTML5 bookmarks
Native HTML5 Bookmarks:

SSH Bookmark:

RDP Bookmark:
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Supported Platforms
The following sections describe the supported platforms and network information for Mobile Connect:
• Apple Product Support
• SonicWall Appliance Support
• Required Network Information

Apple Product Support
SonicWall Mobile Connect is supported on the following devices:
• iPhone XS, XS Max, and XR - running iOS 12 or higher
• iPhone X - running iOS 11 or higher
• iPhone 8 and 8 Plus - running iOS 11 or higher
• iPhone 7 and 7 Plus - running iOS 10 or higher
• iPhone 6s and 6s Plus - running iOS 9 or higher
• iPhone 6 and 6 Plus - running iOS 9 or higher
• iPhone 5, 5c and 5s - running iOS 9 or higher
• iPhone 4 and 4S - running iOS 9 or higher
• iPad Pro - running iOS 9 or higher
• iPad Air 2 - running iOS 9 or higher
• iPad Air (5th generation) - running iOS 9 or higher
• iPad (4th generation) - running iOS 9 or higher
• iPad (3rd generation) - running iOS 9 or higher
• iPad 2 - running iOS 9 or higher
• iPad mini 4 - running iOS 9 or higher
• iPad mini 3 - running iOS 9 or higher
• iPad mini (2nd generation) - running iOS 9 or higher
• iPad mini - running iOS 9 or higher
• iPod touch (5th generation or later) - running iOS 9 or higher
NOTE: Devices running iOS 8 or earlier with earlier versions of SonicWall Mobile Connect cannot update to
Mobile Connect 5.0.0 for iOS from the App Store unless they are upgraded to iOS 9 or newer.

SonicWall Appliance Support
SonicWall Mobile Connect is a free application, but requires a concurrent user license on one of the following
SonicWall solutions to function properly:
• SonicWall firewall appliances including the TZ, NSa, NSA, E-Class NSA, and SuperMassive™ 9000 Series
running SonicOS 5.9 or higher
• SonicWall Secure Mobile Access 100 Series / SRA appliances running 8.5 or higher
SonicWall Mobile Connect 5.0 User Guide
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• SonicWall Secure Mobile Access 1000 Series / E-Class SRA appliances running 11.4 or higher

Required Network Information
To use Mobile Connect, the following information is needed from your network administrator or IT Support:
• Server name or address – This is either the IP address or URL of the SSL VPN server to which you are
connecting. The SSL VPN server can be any supported SonicWall appliance. See SonicWall Appliance
Support.
• Username and password – Typically, you are required to enter your username and password, although
some connections might not require this.
• Domain name – The domain name of the SSL VPN server. Mobile Connect might be able to automatically
determine this when it first contacts the server or there could be multiple domains that can be selected.
The administrator controls the number of domains listed, in addition to Choose during login.

DNS Domain Settings on Appliances
Before Mobile Connect users are able to access the private network, the network administrator must configure
the DNS Domain on the SonicWall appliance. When the Mobile Connect user accesses a URL on the private
network, the configured DNS domain is used to resolve the hostname lookup. For public domains that do not
match the configured DNS domain, the DNS server for the Wi-Fi or cellular network is used.
NOTE: The Mobile Connect user does not need to do any configuration tasks related to DNS. The
information below is for SonicWall network administrators.
The DNS Domain configuration process varies, depending on the type of SonicWall appliance being used:
• SonicWall firewall appliances - On the SSL VPN > Client Settings page, enter the DNS domain name in the
DNS Domain field.
• SonicWall SMA 100 Series / SRA appliances - The DNS domain can be configured either globally, at the
group level, or at the individual user level:
• Global level – On the Network > DNS page, enter the DNS domain name in the DNS Domain field.
• Group level – On the Users > Local Groups page, click the edit icon for the group. Click on the
NetExtender/Mobile Connect tab and enter the DNS domain the DNS Domain field.
• User level – On the Users > Local Users page, click the edit icon for the user. Click on the
NetExtender/Mobile Connect tab and enter the DNS domain the DNS Domain field.
• SonicWall SMA 1000 Series / E-Class SRA appliances - The DNS domain can be configured either globally
or for specific IP address pools:
• Global level – From the main navigation menu in the Appliance Management Console (AMC),
click Network Settings. In the Name resolution area, click Edit. The Configure Name Resolution
page appears. Enter the DNS domain name in the Search domains field.
• IP address pool level – From the main navigation menu in the AMC, click Services. Under Access
services, in the Network tunnel service area, click Configure. The Configure Network Tunnel
Service page appears. Click the name of the IP address pool you want to edit. The Configure IP
Address Pool page appears. To the right of the Advanced heading, click the
arrow icon.
Select Customize default settings and enter the DNS domain name in the Search domains field.
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Installing and Connecting
This section describes how to install Mobile Connect on your device and how to configure and initiate a VPN
connection using Mobile Connect.

Topics:
• Installing Mobile Connect
• Creating and Saving Connections
• Initiating a Connection
• Configuring Connect on Demand
• Configuring Trusted Network Detection
• Using Apple Configurator 2 with Mobile Connect
• Configuring Per App VPN

Installing Mobile Connect
SonicWall Mobile Connect is installed through the Apple App Store.

To download and install the Mobile Connect app:
1 On your iPhone, iPod touch, or iPad, tap the App Store icon.

2 Go to the Search tab, type in SonicWall Mobile Connect, and tap Search.
3 In the search results, select SonicWall Mobile Connect.
4 Tap Get to Install. When the installation is complete on your device, the SonicWall Mobile Connect icon
appears on your device.

NOTE: If you encounter an error when attempting to download Mobile Connect, see iTunes Store
Customer Support, where you can find troubleshooting procedures and instructions on how to
report the issue using your iTunes account: http://www.apple.com/support/itunes/.

SonicWall Mobile Connect 5.0 User Guide
Installing and Connecting

9

5 Tap Accept for the Mobile Connect privacy policy Statement.

Creating and Saving Connections
The process of creating a Mobile Connect connection is slightly different depending on the type of SonicWall
appliance to which you are connecting.
• Creating Firewall or SMA 100 Series / SRA Connections
• Creating SMA 1000 Series / E-Class SRA Connections

Creating Firewall or SMA 100 Series / SRA
Connections
To create and save a new connection to a SonicWall network security appliance or SMA/SRA:
1 The first time you launch Mobile Connect, tap Add Connection.
NOTE: If you don’t have any connections, you’ll bypass step 2 and see the editor screen under step 5.
2 Then, tap Create a new connection. The info icon takes you to the same place.
3 In the Name field, type in a descriptive name for the connection.
4 In the Server field, type in the URL or IP address of the server (appliance).
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5 Tap Next. Mobile Connect attempts to contact the SonicWall appliance.

6 If Mobile Connect contacts the appliance successfully, the server connection is added to the list of saved
connections on the Connections screen.
If the attempt fails, a warning message displays, asking if you want to save the connection. Verify that the
server address or URL is spelled correctly, and then tap Save.

7 If Mobile Connect successfully contacts the server after you enter your Name and Server name, choose
your Domain name by tapping on the Domain field and selecting from the picker. You can then choose
how to obtain your client certificate by tapping on one of the following:
• Choose during login - You will be prompted to select a certificate if the server requires one.
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• None - If the server requires a certificate, login will be canceled. Then tap Save.

IMPORTANT: The Domain field is auto-populated with the default domain from the server. To select a
different domain, tap Domain to display the available options in the picker, and then select the correct
domain.
NOTE: Entering your Username and Password is optional during this step. If the previous screenshot does
not match what is displayed on your device, you are connecting to the SonicWall SMA 1000 Series / E-Class
SRA appliance. See Creating SMA 1000 Series / E-Class SRA Connections.
8 iOS may present a security prompt to allow SonicWall Mobile Connect to add VPN Configurations.
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9 If prompted, tap Allow. The iOS Settings app opens and you may be prompted for your Touch ID, Face ID,
or passcode to grant the permission.

10 Enter Touch ID, Face ID, or your passcode as required. The Mobile Connect Connections screen where
you select the server connection is then displayed.

Creating SMA 1000 Series / E-Class SRA
Connections
To create and save a new connection to a SonicWall SMA 1000 Series / E-Class SRA appliance:
1 The first time you launch Mobile Connect, tap Add Connection.

2 In the Name field, type in a descriptive name for the connection.
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3 In the Server field, type in the URL or IP address of the server (appliance).
4 Tap Next. Mobile Connect attempts to contact the SonicWall appliance.
• If Mobile Connect contacts the appliance successfully, the server connection is added to the list of
saved connections on the Connections screen.
• If the attempt fails, a warning message displays, asking if you want to save the connection. Verify
that the server address or URL is spelled correctly, and then tap Save.

Clicking Save adds the server connection to the list of saved connections on the Connections
screen.
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Initiating a Connection
After you save a new connection, the Connections screen displays the list of all configured connections.
Connections screen

To initiate a Mobile Connect session:
1 Tap the connection in the list that you want to initiate. The Connection page displays.

2 Tap the VPN switch to enable the VPN.
3 Type your credentials into the Username and Password fields, if prompted (depending on whether the
appliance you are connecting to allows for saving usernames and passwords), and then tap Login.

SonicWall Mobile Connect 5.0 User Guide
Installing and Connecting

15

4 When the connection is successfully established, the Status row changes to Connected and the VPN
switch is on.

Any bookmarks defined for the portal are displayed following the Status row. You can launch a bookmark
by tapping on it.
5 Press the Home button on your iPhone, iPod touch, or iPad to display its home screen. You can now
navigate to other applications to access your Intranet network. The status bar at the top of the iPhone,
iPod touch or iPad displays a VPN icon to indicate that the Mobile Connect session is still connected.

If the VPN connection is interrupted, the VPN icon disappears and you are no longer able to access the
Intranet network. This can happen if your device's connection transitions from wireless to cellular or to
another network type.
Return to Mobile Connect to reestablish the connection. Optionally, you can configure Automatic
Reconnect on the Settings tab to have Mobile Connect automatically attempt to reestablish interrupted
connections.
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Configuring Connect on Demand
The Connect on Demand feature provides the ability for Mobile Connect to automatically establish a VPN
connection when you attempt to access a domain on the private network. This provides a seamless VPN
connectivity experience without the need to manually launch Mobile Connect.
NOTE: Connect on Demand is only available for connections to SonicWall SMA 1000 Series / E-Class SRA
and SonicWall SMA 100 Series / SRA appliances.
See the following:
• Connect on Demand to SMA 1000 Series
• Connect on Demand to SMA 100 Series

Connect on Demand to SMA 1000 Series
The easiest way to determine if Connect on Demand is available for your SMA 1000 Series / E-Class SRA
connection is to look at the Connection screen when a VPN is connected. If the information indicator
appears at the right side of the Status row, Connect on Demand can be configured while connected.
Info indicator

A VPN configuration on the SonicWall SMA 1000 Series / E-Class SRA appliance must meet the following
requirements to support Connect on Demand:
• The VPN tunnel must not be configured for Redirect-All mode.
• The realm must be configured to use client certificates, for authentication. Chained authentication
(where a second authentication server is used) does not support Connect on Demand.
• A valid client certificate for the realm must be present. See Importing Certificates to the iOS Device for
more information.
• The user must successfully connect to the appliance at least one time.
If the Mobile Connect app is not running and user interaction is required for the VPN connection attempt to
succeed, VPN on Demand may fail to connect. Some scenarios where user interaction may be required include
the following:
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• The VPN server's SSL certificate is untrusted.
• Personal Device Authorization is enabled on the server and the device has not been authorized.
• Two-factor user authentication is required such as a one-time password.

To configure Connect on Demand to SonicWall SMA 1000 Series / E-Class SRA:
1 Tap the information indicator
On Demand screen.

in the Status row on the Connection tab that displays the Connect

2 Tap Connect on Demand.
3 Set Domain List to one of the following:
a Set Domain List to Connect If Needed to have Mobile Connect establish a VPN connection when
accessing a resource with any of the domain suffixes listed.
b Set Domain List to Never Connect to disable Connect on Demand for the domain suffixes listed.
4 If more than one domain is listed, you can enable Connect on Demand for individual domains by tapping
on the domain name.
NOTE: Always Connect domains are no longer supported in iOS. They behave the same as Connect if
Needed.

Connect on Demand to SMA 100 Series
On SonicWall SMA 100 Series / SRA appliances, client certificate authentication is available as a second factor
authentication method in addition to standard user name and password authentication. If a client certificate is
required during authentication, the user is automatically prompted to select a client certificate from the iOS
device.
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Selecting a certificate

Tapping on the information indicator
details for the client certificate.

that appears to the right of the client certificate displays additional

Certificate details

By default, a VPN configuration uses the client certificate setting of Choose during login.

SonicWall Mobile Connect 5.0 User Guide
Installing and Connecting

19

To support Connect on Demand, a VPN configuration on the SonicWall SMA 100 Series / SRA appliance must
meet the following requirements:
• The user’s effective client certificate enforcement policy, configured at the domain or user level, must be
enabled to use client certificates for authentication.
• The user’s effective user name and password caching policy (configured at the global, group, or user
level) must be set to Allow saving of username and password.
• The valid client certificate for the user must be present on the iOS device.
• The iOS VPN connection profile must have the user name and password configured, and the appropriate
client certificate must be selected. See Importing Certificates to the iOS Device for more information.

To configure Connect on Demand to SonicWall SMA 100 Series / SRA:
1 Tap Certificate on the Edit Connection screen.
2 Select a client certificate from the list.
The Connect On Demand setting is displayed.

3 Tap Connect On Demand on the Edit Connection screen to enable Connect On Demand and display the
Connect On Demand screen.
4 In the Connect On Demand screen, set Domain List to Connect If Needed to have Mobile Connect
establish a VPN connection when accessing a resource with any of the domain suffixes listed.
Setting Domain List to Never Connect disables Connect on Demand for the domain suffixes listed.
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5 If more than one domain is listed, tap a domain name to enable Connect on Demand for an individual
domain.
NOTE: Always Connect domains are no longer supported in iOS. They behave the same as Connect if
Needed.

Configuring Trusted Network Detection
The Apple Trusted Network Detection (TND) enhancement to the iOS Connect On Demand feature has the
following properties:
• Can be used only with Connect on Demand.
• Extends the Connect on Demand functionality by determining whether the user is on a trusted network.
• Is configured with the Apple Configurator 2.
• Is used for wireless connections only. When operating over other types of network connections, Connect
on Demand does not use TND to determine whether a VPN should be connected.
Connect On Demand starts a VPN connection whenever a user tries to access a destination with a hostname
specified in the domains list. For example, if *.example.com is in the Always Connected list, when a user
accesses internal.example.com, the client starts a VPN connection regardless of the network to which the
device is currently connected. TND compares the VPN and local DNS servers and DNS suffixes to determine
whether to use Mobile Connect and dial the VPN, as shown in the following table:
DNS comparison and effect on login
DNS suffixes

DNS servers

Login

None

None

Refused - no VPN

None

Same

Refused - no VPN

Same

Same

Refused - no VPN

Same

Same and others

Allowed

Same

Different

Allowed

Different

Same

Allowed

Partial match

Partial match

Allowed

A partial match means that if there are two DNS servers configured for TND, but only one DNS server matches
the actual network environment, then the login will still be allowed.
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Consult documentation from Apple Inc. for more information about Trusted Network Detection and Connect on
Demand.
To determine if TND is available for your connection, tap the information indicator in the Status row on the
Connection tab. This displays the Trusted Networks button used to enable/disable TND, if available.
Trusted Networks button

To configure TND:
1 Tap the information indicator

in the Status row on the Connection tab.

2 Ensure that Connect On Demand is turned on.
3 Turn on Trusted Networks.
NOTE: Trusted Network Detection is available only for connections to SonicWall SMA 1000 Series / E-Class
SRA appliances.

Using Apple Configurator 2 with Mobile
Connect
Apple Configurator 2 makes it easy for anyone to mass configure and deploy iPhone, iPad, and iPod touch in
business and education. It lets administrators of enterprise environments create configuration profiles for iOS
devices that provide the ability to preconfigure the device settings for enterprise policies, such as VPN
configuration, security policies, wireless settings, and so on.
Apple Configurator 2 enables administrators to configure Mobile Connect profiles for their users’ iOS devices.
Information about installing and using Apple Configurator 2 is available here:
https://support.apple.com/en-us/HT205285

To Configure a Mobile Connect Profile Using Apple Configurator 2:
1 Download, install and launch Apple Configurator 2.
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2 Click File > New Profile.

SonicWall Mobile Connect 5.0 User Guide
Installing and Connecting

23

3 Select VPN, and then click Configure.

4 In the Connection Name field, enter a name for the connection.

5 In the Connection Type drop-down menu, select Custom SSL.
6 In the Identifier field, enter com.sonicwall.mobileconnect.
7 In the Server field, enter the hostname or IP address for the SonicWall appliance.
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8 (Optional) In the Account field, enter the username for the account.
9 In the Provider Bundle Identifier field, enter com.sonicwall.mobileconnect.extension
10 (Optional) The Custom Data section can be used to configure the LoginGroupOrDomain key and value
which depends on the type of appliance used for the connection:
• For profiles connecting to SonicWall Firewall or SMA 100 Series / SRA appliances, enter the
Domain name in the Value column. The name of the Domain is shown in the Edit Connection
screen of the Mobile Connect application.
• For profiles connecting to SonicWall SMA 1000 Series / E-Class SRA appliances, enter the Login
Group name in the Value column. The Login Group is the same field that is selected in the Log in
to screen, when initiating a connection in Mobile Connect.
11 In the User Authentication drop-down menu, select Password.
12 (Optional for connections to Firewall or SMA 100 Series / SRA appliances) In the Password field, enter
the password for the user account, if the SonicWall appliance you are connecting to is configured to
allow for saving passwords.
NOTE: Only SonicWall Firewall or SMA 100 Series / SRA appliances can store passwords. SonicWall
SMA 1000 Series / E-Class SRA appliances cannot store passwords.
13 (Optional for connections to SonicWall SMA 1000 Series / E-Class SRA appliances) If a proxy server is used
for the connect, in the Proxy drop-down menu, select either Manual or Automatic. If a proxy server is
not used, leave this set to None.
NOTE: Only SonicWall SMA 1000 Series / E-Class SRA appliances support Mobile Connect over
proxy. Currently, SonicWall Firewall and SMA 100 Series / SRA appliances do not support Mobile
Connect over proxy.

Configuring Per App VPN
This section describes how Mobile Connect supports the iOS Per App VPN features. Per App VPN is only
supported for Mobile Connect VPN connections to SMA 1000 Series appliances that have been configured for
Application Access Control.
Per App VPN requires the use of a Mobile Device Management (MDM) solution. In addition, the Per App VPN is
only supported with MDM managed apps as well as Safari through a list of MDM managed web domains. Please
refer to your MDM solution provider's documentation for how to configure Per App VPN with their solution.
The following are known limitations with using Per App VPN and Mobile Connect:
• Application access control Zone classification could fail if the MDM solution does not successfully install
managed applications and configure Per App VPN rules for managed applications.
• Custom VPN connections are not installed for MDM managed VPN connections when connecting to SMA
1000 Series appliances.
• VPN on Demand connections may fail to connect if device authorization is enabled on the SMA 1000
Series appliance. This is due to the fact that user interaction will be required in the application.
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3
Settings, Bookmarks, Files, and
Certificates
This section describes the configurable elements that are accessed from the Settings screen in Mobile Connect,
such as connection settings, URL control, bookmarks, files bookmarks, and how to use Mobile Connect Client
Certificate Importer.

Topics:
• Settings Overview
• URL Control Syntax and Parameters
• Using Bookmarks
• Using Files
• Importing Certificates to the iOS Device

Settings Overview
SonicWall Mobile Connect provides several settings for connection and logging options. The Settings screen also
provides Support information that includes a User Guide, device information, and email logs.
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Settings screen

The available settings and selections are described below:
• Settings Section
• Support Section

Settings Section
The following options are controlled from the Settings section of the Settings screen:
• Connect on Launch - Sets Mobile Connect to automatically initiate a connection to the last-used profile
when the application is launched.
• Automatic Reconnect - Sets Mobile Connect to automatically attempt to reconnect if the connection is
lost. The SSL VPN connection can be disrupted when your device’s connection transitions to a different
network type (for example, from wireless to cellular). This setting lets applications rely on a sustained
VPN connection. There is no limit on the amount of time it takes to reconnect.
• URL Control - Allows other mobile applications to pass action requests using special URLs to Mobile
Connect. These action requests can create VPN connection entries and connect or disconnect VPN
connections. For example, another application can launch Mobile Connect, access internal resources as
needed, and then disconnect by using the mobileconnect:// or
sonicwallmobileconnect:// URL scheme.
Additional information about URL Control is provided in URL Control Syntax and Parameters.
• Touch ID - Set Mobile Connect to prompt for Touch ID during username/password authentication.
Requires connection to servers that have a configured Touch ID policy.
• Face ID - Set Mobile Connect to prompt for Face ID during username/password authentication. Requires
connection to servers that have a configured Face ID policy.
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• Bookmarks - Displays centrally configured shortcuts, called bookmarks, to VPN resources such as URLs,
Outlook Web Access, and iOS applications. These bookmarks, which are displayed on the main
Connection tab when the VPN is connected, provide one-touch access to frequently used applications.
If using an SMA 100 Series / SRA appliance, pulling down the Connection screen and releasing it
refreshes the bookmarks. Mobile Connect supports Remote Desktop options like screen size and
enable/disable audio as long as both the server bookmark and third-party iOS application support the
option.
NOTE: Bookmarks are supported on SonicWall SMA 100 Series / SRA appliances only when running
version 7.5 or higher and on Next Generation Firewall appliances running SonicOS 5.9.0.2 and
higher.
Additional information about bookmarks is provided in Using Bookmarks.
• Files - Deletes all cached files that have been downloaded and stored on the device. Note that cached
files are encrypted on the device for added security.
NOTE: Files are supported on SonicWall SMA 100 Series / SRA appliances only when running 7.5 or
higher and not supported on appliances running SonicOS.
Additional information about Files is provided in Using Files.
• Logs - Serves two purposes:
• Enables full debug log messages of Mobile Connect activity. Leave this section disabled unless
instructed to enable it by SonicWall Support staff.
• Deletes all log files that have been saved on the device.
• Imported Certificate - Allows a user to import client certificates to log into remote servers. These digital
certificates are sent from the client to the server at the start of a session. They prove the identification of
the user to the server. You can import client certificates from apps such as Mail, Outlook, or web
browsers like Safari.

Additional Settings for SMA 1000 Series / E-Class SRA
Two additional options can be modified for connections to SonicWall SMA 1000 Series / E-Class SRA appliances.

To view these options:
1 Go to the Connection tab and tap the Connection line to display the list of connections.
2 Tap the information indicator to the left of the connection you want to modify.
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The Edit Connection screen displays.

The following options can be configured:
• Remember Credentials - Enables saving of user authentication credentials for the VPN connection. This
is enabled by default and can be controlled by the SonicWall SMA 1000 Series / E-Class SRA server
configuration.
• Forget this Login Group - Mobile Connect remembers the Login Group that you specified when
configuring the connection. To change to a different Login Group, tap Forget this Login Group. The next
time you connect to the server, you are prompted to select a new Login Group.
NOTE: If these options are not displayed, then you are connecting to either a SonicWall firewall or
SMA 100 Series / SRA appliance.

Support Section
The following selections are available in the Support section of the Settings screen:
• User Guide - Displays the SonicWall Mobile Connect User Guide.
• Device Information - Displays information about the iOS device, wireless connection, cellular
connection, Bluetooth connection, and DNS servers.
• Email Logs - Creates an email to send the Mobile Connect log files to SonicWall Support staff. Tap Send to
send the email.

URL Control Syntax and Parameters
This section provides the full set of URL parameters for the URL Control feature. URL Control currently supports
the addprofile, connect, and disconnect commands. Callback URLs are also supported.

Topics:
• Using the addprofile Command
• Using the Connect Command
• Using the Disconnect Command
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• Using the callbackurl Command Parameter

Using the addprofile Command
The addprofile command requires either the name or server parameter, and accommodates both. All other
parameters are optional. When the URL is opened in Mobile Connect, all of the parameters included in the URL
are saved in the connection entry associated with that name and server.

Syntax:
mobileconnect://addprofile[/]?name=ConnectionName&server=ServerAddress
[&Parameter1=Value&Parameter2=Value...]
addprofile command parameters
Command parameter

Description

name

The unique name of the VPN connection entry that is created and appears in the
Mobile Connect Connections list. Mobile Connect accepts the name only if it is
unique. Letters are case sensitive.

server

The domain name or IP address of the SonicWall appliance to which you wish to
connect. For example: vpn.example.com

username

Optional: The username used in the VPN connection.

password

Optional: The password used in the VPN connection.

realm

Optional: The realm used in the VPN connection profile. Applies to SMA 1000
Series / E-Class SRA connections only.

domain

Optional: The domain used in the VPN connection profile. Applies to SMA 100
Series / SRA and Firewall connections only.

sessionid

Optional: The session ID or Team ID used for authentication.

connect

Optional: If presented and the value is non-null, the connection is initiated if the
profile was successfully added.

callbackurl

Optional: The callback URL to be opened by Mobile Connect after the
addprofile command has been processed. See Using the callbackurl
Command Parameter for full details of the callback URL syntax and options.

Examples:
Following are examples of the addprofile command:
mobileconnect://addprofile/?name=Example&server=vpn.example.com
sonicwallmobileconnect://addprofile/?name=Example&server=vpn.example.com
mobileconnect://addprofile?name=Example%202&server=vpn.example.com
mobileconnect://addprofile?name=vpn.example.com
mobileconnect://addprofile?server=vpn2.example.com
mobileconnect://addprofile?name=SRA%20Connection&server=sslvpn.example.com
&username=test&password=password&domain=LocalDomain&connect=1
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mobileconnect://addprofile?name=EX%20Connection&server=workplace.example.co
m
&username=test&password=password&realm=Corp&connect=1
NOTE: All appropriate characters in values of parameters used in URLs are required to be URL encoded. For
instance, to match a space, enter %20.

Using the Connect Command
The connect command is used to easily establish VPN connections. Connection information can be embedded
in the URLs and they can be provided to users for easy setup and configuration. In addition, a callback URL can
be provided that Mobile Connect opens after the connection attempt is completed, making it possible for other
applications to initiate VPN connections in a seamless manner.

Syntax:
mobileconnect://connect[/]?[name=ConnectionName|server=ServerAddress]
[&Parameter1=Value&Parameter2=Value...]
connect command parameters
Command parameter

Description

name

The unique name of the VPN connection entry that is created and appear in the
Mobile Connect Connections list. Mobile Connect accepts the name only if it is
unique. Letters are case sensitive.

server

The domain name or IP address of the SonicWall appliance in which you wish to
connect. For example: vpn.example.com

username

Optional: The username used in the VPN connection.

password

Optional: The password used in the VPN connection.

realm

Optional: The realm used in the VPN connection profile. Applies to SMA 1000
Series / E-Class SRA connections only.

domain

Optional: The domain used in the VPN connection profile. Applies to SMA 100
Series / SRA and Firewall connections only.

sessionid

Optional: The session ID or Team ID used for authentication.

connect

Optional: If presented and the value is non-null, the connection is initiated if the
profile was successfully added.

callbackurl

Optional: The callback URL is opened by Mobile Connect after the connect
command has been processed. See Using the callbackurl Command Parameter for
full details of callbackurl syntax and options.

Examples:
Following are examples of the connect command:
mobileconnect://connect/?name=Example
sonicwallmobileconnect://connect/?name=Example
mobileconnect://connect?name=Example
mobileconnect://connect?server=vpn.example.com
mobileconnect://connect?name=Example%202&server=vpn.example.com
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mobileconnect://connect?name=SRA%20Connection&server=sslvpn.example.com
&username=test&password=password&domain=LocalDomain
mobileconnect://connect?name=EX%20Connection&server=workplace.example.com
&username=test&password=password&realm=Corp

Using the Disconnect Command
The disconnect command is used to disconnect an active connection. In addition, a callback URL can be
provided that Mobile Connect opens after the connection is disconnected that makes it possible to return to the
calling application. If there is no active VPN connection, the disconnect command is ignored.

Syntax:
mobileconnect://disconnect[/]
mobileconnect://disconnect[/]?[callbackurl=CallBackURL]
disconnect command parameters
Command parameter

Description

callbackurl

Optional: The URL defined for callbackurl is opened by Mobile Connect
after the disconnect command has been processed. See Using the callbackurl
Command Parameter for full details of callbackurl syntax and options.

Examples:
Following are examples of the disconnect command:
mobileconnect://disconnect
mobileconnect://disconnect/
sonicwallmobileconnect://disconnect
mobileconnect://disconnect?callbackurl=customapp%3A%2F%2Fhost%3Fstatus%3D%2
4STATUS
%24%26login_group%3D%24LOGIN_GROUP%26error_code%3D%24ERROR_CODE%24
sonicwallmobileconnect://disconnect?callbackurl=customapp%3A%2F%2Fhost%3Fst
atus%3D
%24STATUS%24%26login_group%3D%24LOGIN_GROUP%26error_code%3D%24ERROR_CODE%24

Using the callbackurl Command Parameter
callbackurl is an optional query string argument for each of the connect/disconnect/addprofile
commands. If a callback URL is included in a command, then that URL will be launched by Mobile Connect once
the command has been completed. While invoking Mobile Connect using a URL, a third-party application can
use the callbackurl parameter to include a URL to be launched by Mobile Connect.
The callbackurl value can contain special tokens that are evaluated and dynamically replaced by Mobile
Connect to provide additional status and connection information back to the application that is opened by the
callback URL. Tokens are evaluated in place, in the same order that the tokens were specified.
To ensure that it functions properly, the base callbackurl URL value format should be RFC 1808 compliant
and should be able to be launched independently of Mobile Connect. For example, it should launch through a
web page or iOS web clip.
SonicWall Mobile Connect 5.0 User Guide
Settings, Bookmarks, Files, and Certificates

32

URL syntax:
<scheme>://<net_loc>/<path>;<params>?<query>#<fragment>
NOTE: The URL value of callbackurl must be properly URL encoded to ensure that Mobile Connect
can process the callback URL correctly. All appropriate characters in values of parameters used in URLs are
required to be URL encoded. For instance, to match a space, enter %20.
Any number of dynamic tokens from Dynamic tokens supported by callbackurl can be specified in the <query>
element of the URL. These can be used by administrators when configuring the callback URLs on a web site or in
an email to their users, such as to auto-configure a VPN profile. The dynamic tokens are useful because they
allow Mobile Connect to provide information to the website or app that is being launched when the callback
URL is opened.
Dynamic tokens supported by callbackurl
Dynamic token

Description

$ERROR_CODE$

The numerical value of the error from the failed connection attempt.

$ERROR_MESSAGE$

The string value of the error message from the failed connection attempt.

$LOGIN_GROUP$

The string value of the authentication login group or realm. Applies to SMA 1000
Series / E-Class SRA connections only.

$COMMUNITY$

The string value of authentication community. Applies to SMA 1000 Series / EClass SRA connections only.

$ZONE$

The string value of EPC (End Point Control) zone. Applies to SMA 1000 Series / EClass SRA connections only.

$TUNNEL_IP$

The string value of the Mobile Connect IPv4 client address.

$TUNNEL_MODE$ One of split, split-nonlocal, redirectall, or redirectallnonlocal, depending on the tunnel mode. Applies to SonicWall SMA 1000
Series / E-Class SRA connections only.
$ESP_ENABLED$

One of yes or no, depending on if ESP (Encapsulating Security Payload) is
enabled. Applies to SonicWall SMA 1000 Series / E-Class SRA connections only.
ESP is a protocol used to provide confidentiality, data origin authentication,
connectionless integrity, an anti-replay service (a form of partial sequence
integrity), and limited traffic flow confidentiality.

Examples:
Following are examples using callbackurl:
Callback URL (1):
customapp://host?status=$STATUS$&login_group=$LOGIN_GROUP&error_code=
$ERROR_CODE$
Corresponding full URL with URL encoded callbackurl value:
mobileconnect://connect?sessionid=<teamid>&callbackurl=customapp%3A%2F
%2Fhost
%3Fstatus%3D%24STATUS%24%26login_group%3D%24LOGIN_GROUP%26error_code%3
D%24
ERROR_CODE%24
Callback URL (2):
myapp://callback?status=$STATUS$&login_group=$LOGIN_GROUP&error_code=
$ERROR_CODE$
Corresponding full URL with URL encoded callbackurl value:
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mobileconnect://connect?sessionid=<teamid>&callbackurl=myapp%3A%2F%2Fc
allback
%3Fstatus%3D%24STATUS%24%26login_group%3D%24LOGIN_GROUP%26error_code%3
D%24
ERROR_CODE%24
Callback URL (3):
http://server/example%20file.html
Corresponding full URL with URL encoded callbackurl value:
mobileconnect://connect?callbackurl=http%3A%2F%2Fserver%2Fexample%20fi
le.html

Using Bookmarks
Topics:
• Showing and Filtering Bookmarks
• Supported Bookmark Types

Showing and Filtering Bookmarks
The Mobile Connect Connection screen displays the configured bookmarks. The list of bookmarks can be
filtered by tapping the Showing: <bookmark type> row that is displayed when there are more than five
bookmarks. This lets you filter long lists of bookmarks by type. Select the type of bookmarks to display or select
All to display all bookmarks.
Showing bookmarks

Selecting a bookmark for an application that is not installed prompts you to install the application. Applications
referenced by bookmarks also can be installed at any time using the Settings > Bookmarks screen.
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In addition to installing applications for bookmarks, the Settings > Bookmarks screen is also used to select and
install applications for bookmarks that support multiple third-party applications. For example, you might select
Safari and Google Chrome for a Web bookmark.
Web bookmark with multiple apps

Supported Bookmark Types
This section describes the types of bookmarks and associated applications that are supported by Mobile
Connect.
NOTE: In Mobile Connect iOS 5.0, only Web and Desktop bookmarks are supported on the SonicWall SMA
1000 Series / E-Class SRA appliances.

Topics:
• Desktop Bookmarks
• Web Bookmarks
• Mobile Connect Bookmarks
• Terminal Bookmarks

Desktop Bookmarks
Desktop bookmarks have a name that appears on the user portal, and an internal type.
Several types of desktop bookmarks are supported:
• RDP Bookmarks
• VNC Bookmarks
• Citrix Bookmarks
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RDP Bookmarks
RDP bookmark portal names and internal types
Portal name

Internal type

Terminal Services (RDP – ActiveX)

RDP5ActiveX

Terminal Services (RDP – Java)

RDP5Java

Terminal Services (RDP – HTML5)

RDP5HTML5

NOTE: RDP (HTML5) bookmarks are launched within Mobile Connect and do not launch a third-party app.
RDP bookmark types attempt to launch with the associated RDP application, as configured in the Settings
screen. See RDP applications and minimum supported versions.
RDP applications and minimum supported versions
Application

Minimum supported version

Microsoft Remote Desktop

8.1.35

Parallels Client (legacy 2X)

15.0.3883

Additional details such as screen resolution should be provided to the client. However, support for passing such
parameters varies based on the application. For example:
• Parallels 2X Client does not accept screen resolution settings on iOS

VNC Bookmarks
VNC bookmark portal names and internal types
Portal name

Internal type

Virtual Network Computing (VNC)

VNC

Virtual Network Computing (VNC – HTML5)

VNCHTML5

NOTE: VNC (HTML5) bookmarks are launched within Mobile Connect and do not launch a third-party app.
VNC bookmark types attempt to launch with the associated VNC application as configured in the Settings
screen.
VNC applications and minimum supported versions
Application

Minimum supported version

Remoter VNC

4.8.10

Additional details such as screen resolution should be provided to the client. However, support for passing such
parameters varies based on the application.
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Citrix Bookmarks
Citrix bookmark portal names and internal types
Portal name

Internal type

Citrix Portal (Citrix)

Citrix

Citrix Portal (Citrix)

Citrix_https

Citrix bookmark types attempt to launch with the associated Citrix application.
Citrix application and minimum supported version
Application

Minimum supported version

Citrix Receiver

7.3

Additional details such as screen resolution should be provided to the client. However, support for passing such
parameters varies based on the application.

Web Bookmarks
Web bookmarks have a name that appears on the user portal, and an internal type.
Web bookmark portal names and internal types
Portal name

Internal type

Web (HTTP)

HTTP

Secure Web (HTTPS)

HTTPS

External Web Site

URL

External Web Site

URL_https

These bookmarks launch in an associated web browser and the provided “Name or IP Address” (HostID) is
passed as the parameter to display in the browser.
Browser types and minimum supported versions
Browser type

Minimum supported version

Any browser

—

Safari

Any

Google Chrome

61.0.3163.73

Mobile Connect Bookmarks
Mobile Connect bookmarks have a name that appears on the user portal, and an internal type.
Mobile Connect bookmark portal names and internal types
Portal name

Internal type

Mobile Connect

MC

The Mobile Connect bookmark type relies fully on the OS to determine and launch the proper application. The
bookmark is expected to be properly configured for launch. The Mobile Connect application attempts to launch
it as is. (For example, telnet://server).
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Terminal Bookmarks
Terminal bookmarks have a name that appears on the user portal, and an internal type.
Terminal bookmark portal names and internal types
Portal name

Internal type

Telnet

Telnet

Telnet (HTML5)

TelnetHTML5

Secure Shell Version 1 (SSHv1)

SSH

Secure Shell Version 2 (SSHv2)

SSHv2

Secure Shell Version 2 (HTML5)

SSHv2HTML5

NOTE: The Telnet (HTML5) & SSH (HTML5) bookmarks are launched within Mobile Connect and do not
launch a third-party app.
The applications and versions are:
Terminal applications and minimum supported versions
Application

Minimum supported version

ServerAuditor

2.2.2

vSSH

1.11

vSSH Lite

1.11

Using Files
Mobile Connect 5.0 supports secure mobile access to files through File bookmarks. File bookmarks allow secure
access to files by first checking and enforcing the server configured file policy, and then securely downloading
and displaying the file within the Mobile Connect application.
Server configured policies include control over whether a file can be printed, copied to the clipboard, opened in
a third-party application, or securely cached on the iOS device. File bookmarks can also be created to folders or
file share root directories to allow directory navigation.
NOTE: In Mobile Connect for iOS 5.0, File bookmarks are supported only on the SonicWall SMA 100 Series
/ SRA appliances with SRA 7.5 or later firmware. Support for File bookmarks in SMA 1000 Series / E-Class
SRA and Next Generation Firewall appliances is expected in a future release.
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When File bookmarks are configured for the user on the server appliance, they appear in the list of bookmarks
after the VPN is established and can be filtered by selecting the Showing: Files row that is displayed when there
are more than five bookmarks. See Showing Files bookmarks.
Showing Files bookmarks

Selecting a File bookmark queries the server and enforces any file policies configured on the server for that File
bookmark. If the file is not already cached on the device, the file is securely downloaded from the SMA 100
Series / SRA appliance. After the file is downloaded, it is displayed within the Mobile Connect application. See
Downloading a file using a File bookmark.
Downloading a file using a File bookmark
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Selecting a File bookmark to a folder or directory allows directory browsing, including download and viewing of
any file in the folder. Each attempt to browse a file folder or view a file queries the server to enforce access
policies. See Browsing folders and viewing files.
Browsing folders and viewing files

For information about supported file types and other actions you can take on files, see Files Features.

Files Features
A number of file types are supported with features allowing you to perform many important functions with the
files you access via Files bookmarks.
See the following:
• Supported File Types
• Unsupported File Types
• File Policies and Actions

Supported File Types
Mobile Connect supports the file types natively supported by Apple iOS, as shown in Supported file types.
Supported file types
File type

File extension

Images

.jpg, .jpeg, .tif, .tiff, .png

Music

.mp3, .m4a, .wav

Movies

.mov, .mp4

Microsoft Word documents

.doc, .docx

Microsoft Excel spreadsheets

.xls, .xlsx

Microsoft PowerPoint
presentations

.ppt, .pptx

Adobe PDF

.pdf

Keynote presentations

.key
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Supported file types
File type

File extension

Pages documents

.pages

Numbers spreadsheets

.numbers

Web pages

.htm, .html

Text and Rich-text files

.txt, .rtf

Unsupported File Types
If a file type is not supported, an Unsupported file message is displayed identifying that the file might not be
viewable unless another application is installed that can view the file. Tap Try Anyway to try opening the file
with another application that might be registered to handle that file type. See Trying to open an unsupported
file.
Trying to open an unsupported file

File Policies and Actions
On iOS, policies can be configured on the server to control the actions you can take with a file, including:
• Print
• Copy to the clipboard
• Open in a third-party application
• Securely cached on the device
If a file has an Allow policy (Allow Print, Allow Copy, or Allow Open In) enabled, a Share button is displayed in
the top right of the navigation bar when the file is viewed.
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Share button

See the following sections:
• Allow All Actions
• Allow Print
• Allow Copy
• Allow Open in an Application

Allow All Actions
When all file policies are allowed by the server, tapping the Share button displays the icons for all actions you
can take with a file.
All action buttons
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Allow Print
If the file has the Allow Print policy enabled, tapping Share displays the Print button.
Print button
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Allow Copy
If the file has the Allow Copy policy enabled, tapping the Share button displays the Copy button.
Copy button
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Allow Open in an Application
If the file has the Allow Open in policy enabled, tapping the Share button displays the Open in button and icons
for other applications that can open the file.
Tapping the Open in button displays a list of applications that can open the file.
Open in button and apps

Importing Certificates to the iOS Device
Most Mobile Device Management products can push client certificates to the iOS device, but due to iOS security
restrictions, SonicWall Mobile Connect accesses client certificates by importing them into the application
keychain.
There are three ways to import client certificates to the iOS device using Mobile Connect. They are Apple
Configurator 2, Mobile Device Management, and the Mobile Connect Client Certificate Importer feature.

Topics:
• Using Apple Configurator 2 for Certificate Import
• Using Mobile Device Management for Certificate Import
• Using Mobile Connect Client Certificate Importer
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Using Apple Configurator 2 for Certificate Import
This section provides procedures for creating a profile and importing a client certificate with Apple Configurator
2.

Creating a profile to import a client certificate using Apple Configurator 2:
1 Install and launch Apple Configurator 2.
NOTE: Apple Configurator 2 is a free download from the App Store and is only available on MacOS. You’ll
need a Mac computer to perform this function as you cannot perform it on your iOS device.
2 Go to File and then New Profile.
3 In the General section:
a Give the profile a name. The name will appear in the iOS Settings app during installation, and later
under Settings > General > Profiles.
b Configure the remaining General options as desired. Default values will work fine for one-off
installations.
4 In the Certificates section:
a Click the Configure button.
b Select the certificate file (if you have more than one, just select one for now)
c

Enter the certificate file password if there is one.

d (Optional) If you have more certificates to add (such as CA cert), click the + button in the top right
and repeat the steps.
5 In the VPN section:
a Click the Configure button.
b Fill in the fields as follows:
a) Connection Name:
b) Connection Type: Custom SSL
c) Identifier: com.sonicwall.mobileconnect
d) Server: <the VPN server>
e) Account: <the username on the VPN server>
f) Provide Bundle Identifier: com.sonicwall.mobileconnect.extension
g) Custom Data:
LoginGrouporDomain: A valid login group or domain on the designated VPN server.
Or you can omit this, and Mobile Connect will prompt the user.
h) User Authentication: Certificate
i) Credential: <select the certificate you added in Certificates>
j) Enable VPN on Demand: Optional. Configure as you wish.
6 (Optional) Sign the profile by going to File > Sign Profile. If you do this, it will reduce the security
warnings shown during import on the iOS device. You will be prompted to select a signing certificate, and
will not be able to make any further changes to the profile without unsigning it (File > Unsign Profile).
7 Go to File > Save.
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Importing a client certificate using Apple Configurator 2:
1 In the main window of Apple Configurator 2, right-click the iOS device and choose Add > Profiles.
2 Select the profile.
3 Unlock the iOS device if locked.
4 On the iOS device, the Settings app should launch automatically and show a security prompt. The exact
prompt will vary depending on how many VPN and certificate payloads are being imported, whether the
iOS device is supervised, and whether the profile is signed. You many need to manually tap Install, or be
required to authenticate on the iOS device.

Using Mobile Device Management for Certificate
Import
Importing a client certificate using Mobile Device Management:
1 Email your .mobileprovision file (from the “How to create...” section) to an address which is configured
in Apple Mail on the iOS device.
2 Open the mail on the iOS device.
3 Tap on the attached .mobileprovision file in the email. The Settings app should launch automatically and
show a security prompt. The exact prompt will vary depending on how many VPN and certificate
payloads are being imported, whether the iOS device is controlled by Mobile Device Management, and
whether the profile is signed. You may be required to authenticate on the iOS device.

Using Mobile Connect Client Certificate Importer
Importing a client certificate using Mobile Connect Client Certificate Importer:
1 From your iOS device, open the administrator email message that contains an attached client certificate
and private key in a p12 file format, for example: cert.p12.
2 If using the standard Apple Mail app, press and hold the attachment. In Outlook, and in other apps, press
the Share button with the up arrow.
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3 Tap the three dots (...) labeled More in the middle row to get to the Activities list.

4 Enable the Import to Mobile Connect toggle next to the app icon and tap Done.

5 Tap the Import to Mobile Connect icon in the app Activities menu.
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6 Enter the p12 file password (if prompted) and tap Import to get the certificate.

7 A checkmark verifies that the certificate is successfully imported.
NOTE: After completing this process, the certificate is available in Mobile Connect whenever a server
requires the user to provide it.
TIP: A .p12 file follows the PKCS #12 standard for storing cryptography objects as a single file. Each .p12
file bundles a private key with a corresponding X.509 certificate.
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4
Monitoring and Troubleshooting
This section discusses the Monitoring screen and provides troubleshooting tips, including how to contact
Support from within Mobile Connect.

Topics:
• Monitoring Mobile Connect
• Troubleshooting Mobile Connect

Monitoring Mobile Connect
The Monitor screen displays additional details about the connection, statistics on traffic transmitted, DNS
information, and routes that have been installed.
Monitor screen
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The About screen of Mobile Connect displays the version number and legal text.
About screen

Troubleshooting Mobile Connect
If you are unable to connect to the SonicWall server, complete the following steps to troubleshoot
the connection:
1 Double-check that you have entered the server name properly in the connection configuration.
2 Go to the Safari browser on your iPhone, iPod touch, or iPad and attempt to navigate to the SMA/SRA
appliance web portal.
3 If you are unable to load the web portal, the problem is with the SonicWall appliance. Contact your
network administrator if the problem persists.
4 If the web portal loads successfully on the Safari browser and you still cannot establish a Mobile Connect
connection, notify SonicWall Support, as follows:
a On the Settings tab, enable Debug Logging.
b Attempt a connection to the server again to ensure that full debugging messages are logged for
the attempt.
c

Then return to the Settings tab and tap Email Logs. An email launches in your mail client with the
Mobile Connect log attached. Address the email to Support@sonicwall.com. Add any additional
comments to the email and tap Send. SonicWall Support staff will contact you after reviewing
your case.
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A
SonicWall Support
Technical support is available to customers who have purchased SonicWall products with a valid maintenance
contract and to customers who have trial versions.
The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a
day, 365 days a year. To access the Support Portal, go to https://www.sonicwall.com/support.
The Support Portal enables you to:
• View knowledge base articles and technical documentation
• View video tutorials
• Access MySonicWall
• Learn about SonicWall professional services
• Review SonicWall Support services and warranty information
• Register for training and certification
• Request technical support or customer service
To contact SonicWall Support, visit https://www.sonicwall.com/support/contact-support.
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Copyright © 2018 SonicWall Inc. All rights reserved.
SonicWall is a trademark or registered trademark of SonicWall Inc. and/or its affiliates in the U.S.A. and/or other countries. All other
trademarks and registered trademarks are property of their respective owners
The information in this document is provided in connection with SonicWall Inc. and/or its affiliates’ products. No license, express or
implied, by estoppel or otherwise, to any intellectual property right is granted by this document or in connection with the sale of SonicWall
products. EXCEPT AS SET FORTH IN THE TERMS AND CONDITIONS AS SPECIFIED IN THE LICENSE AGREEMENT FOR THIS PRODUCT,
SONICWALL AND/OR ITS AFFILIATES ASSUME NO LIABILITY WHATSOEVER AND DISCLAIMS ANY EXPRESS, IMPLIED OR STATUTORY
WARRANTY RELATING TO ITS PRODUCTS INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE, OR NON- INFRINGEMENT. IN NO EVENT SHALL SONICWALL AND/OR ITS AFFILIATES BE LIABLE FOR ANY DIRECT,
INDIRECT, CONSEQUENTIAL, PUNITIVE, SPECIAL OR INCIDENTAL DAMAGES (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION OR LOSS OF INFORMATION) ARISING OUT OF THE USE OR INABILITY TO USE THIS DOCUMENT, EVEN IF
SONICWALL AND/OR ITS AFFILIATES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SonicWall and/or its affiliates make no
representations or warranties with respect to the accuracy or completeness of the contents of this document and reserves the right to
make changes to specifications and product descriptions at any time without notice. SonicWall Inc. and/or its affiliates do not make any
commitment to update the information contained in this document.
For more information, visit https://www.sonicwall.com/legal.
End User Product Agreement
To view the SonicWall End User Product Agreement, go to: https://www.sonicwall.com/en-us/legal/license-agreements.
Open Source Code
SonicWall is able to provide a machine-readable copy of open source code with restrictive licenses such as GPL, LGPL, AGPL when applicable
per license requirements. To obtain a complete machine-readable copy, send your written requests, along with certified check or money
order in the amount of USD 25.00 payable to “SonicWall Inc.”, to:
General Public License Source Code Request
SonicWall Inc. Attn: Jennifer Anderson
1033 McCarthy Blvd
Milpitas, CA 95035
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